
        
            
                
            
        

     
   
    
 
    
 
   Change History
 
    
     
      
       
       	 Date
  
       	 Description
  
      
 
      
      
       
       	 September 12, 2024
  
       	 Additional open issue CSCwm07977.
  
      
 
       
       	 May 07, 2024
  
       	 Nexus Dashboard release 3.1.1l became available.
  
      
 
       
       	 March 07, 2024
  
       	 Release 12.2.1 became available.
  
      
 
      
    
 
   
 
   Product Overview
 
   Cisco Nexus Dashboard Fabric Controller (NDFC) is the comprehensive management solution for all NX-OS deployments spanning LAN, SAN, and IP Fabric for Media (IPFM) networks in data centers powered by Cisco. Cisco NDFC also supports devices such as IOS XE switches, IOS XR routers, and third-party devices. Being a multi-fabric controller, Cisco NDFC manages multiple deployment models like VXLAN EVPN, Classic 3-Tier, FabricPath, and Routed Fabrics for LAN while providing ready-to-use control, management, monitoring, and automation capabilities. In addition, when enabled as a SAN Controller, NDFC automates Cisco Multilayer Director Switches (MDS) and Cisco Nexus Family infrastructure in NX-OS mode with a focus on storage-specific features and analytics.
 
   This document describes the features, bugs, and limitations for Cisco NDFC release 12.2.1.
 
   Cisco NDFC focuses on control and management for three primary market segments:
 
   ●    LAN including VXLAN EVPN, VXLAN EVPN Multi-Site, Classic Ethernet, and External fabrics supporting Cisco Nexus switches with NX-OS, additional support for IOS XR, IOS XE, and adjacent host, compute, virtual machine, and container management systems.
 
   ●    SAN for Cisco MDS and Cisco Nexus switches with NX-OS, including support for integration with storage arrays and additionally host, and Virtual Machine systems.
 
   ●    Media control for Multicast video production networks using Cisco Nexus switches operating as standalone NX-OS, with additional integrations for 3rd-party media control systems.
 
   
 Cisco NDFC documentation is provided both online at cisco.com and in-product on the Help Center in the GUI (see Related Content for more information). Information in the in-product documentation is sometimes outdated. See the online documentation for the latest information.
 
   Cisco NDFC and Nexus Dashboard
 
   Cisco NDFC is available as an application running exclusively with Cisco Nexus Dashboard Virtual or Physical Appliance.
 
   Virtual Nexus Dashboard deployment with OVA is also referred to as virtual Nexus Dashboard (vND) deployment, while the deployment of Nexus Dashboard on physical appliance (Service Engine) is known as physical Nexus Dashboard (pND) deployment. 
 
   To deploy Nexus Dashboard based on your requirement, refer to the Cisco Nexus Dashboard Deployment Guide. To deploy NDFC, download the image from the Software Download page; individual services’ installation images are no longer available from the Cisco DC App Center.
 
   The following table shows the compatible versions for Nexus Dashboard and services.
 
    
     
      
       
       	 Services
  
       	 Compatible Version
  
      
 
      
      
       
       	 Nexus Dashboard
  
       	 3.11k, 3.1.1l
  
      
 
       
       	 Nexus Dashboard Fabric Controller
  
       	 12.2.1
  
      
 
      
    
 
   
 
   Note:      While Nexus Dashboard release 3.1.1k is supported with Nexus Dashboard Fabric Controller 12.2.1, we recommend that you use Nexus Dashboard release 3.1.1l instead with Nexus Dashboard Fabric Controller 12.2.1.
 
   Note:      Cisco will no longer support the deployment of Nexus Dashboard (ND) on Red Hat Enterprise Linux (RHEL) in any future releases. Cisco Nexus Dashboard release 3.0.1 and Cisco Nexus Fabric Controller (NDFC) 12.1.3b will be the last releases that this form factor will support. Please work with partners or Cisco representative to leverage other supported form factors for future releases.
 
   Cohosting of NDFC-Managed mode with Nexus Dashboard Insights (NDI)
 
   For information about supported scale for NDFC and NDI co-hosted on the same Nexus Dashboard Cluster, see Verified Scalability Guide for Cisco Nexus Dashboard Fabric Controller.
 
   For information about supported scale for NDFC on Nexus Dashboard Cluster, and Insights and Orchestrator services on a different Nexus Dashboard Cluster, see Verified Scalability Limits for Nexus Dashboard Insights.
 
   System Requirements
 
   For details about the tested and verified hardware and software specifications for Cisco NDFC, see Verified Scalability Guide for Cisco Nexus Dashboard Fabric Controller. 
 
   New Software Features
 
   The following sections include information about the new features, enhancements, and hardware support introduced in this release.
 
   Common Enhancements to all Personas
 
    
     
      
       
       	 Product Impact
  
       	 Features
  
       	 Description
  
      
 
      
      
       
       	 Base Functionality
  
       	 Added support for new Cisco Nexus switches
  
       	 Support added for the Cisco Nexus N9K-C93400LD-H1 and Cisco Nexus N9K-C93108TC-FX3 switches. For more information, see the “New Hardware Features” section in the Nexus Dashboard Fabric Controller Release Notes, Release 12.2.1.
  
      
 
       
       	 Ease of Use
  
       	 Updates to navigation menu
  
       	 Beginning with NDFC release 12.2.1, all the navigation menu items have been clubbed into four categories: Overview, Manage, Analyze, and Admin. Every sub-menu option that was available in prior releases has been re-mapped to one of these main categories.
  
      
 
       
       	 Ease of Use
  
       	 Added an NDFC journey for the first-time setup of the Fabric Controller
  
       	 When the Fabric Controller is enabled during the Nexus Dashboard (ND) bootstrap process, the ND cluster is brought up with the corresponding service already enabled. However, for the first-time setup of the Fabric Controller, the user is led through a guided step-by-step workflow (journey) for the initial bring-up of the Fabric Controller persona and the corresponding feature/feature-sets and pre-requisites that need to be enabled.
  
      
 
       
       	 Ease of Use
  
       	 Upgrade groups for switches in a fabric 
  
       	 Beginning with NDFC release 12.2.1, for LAN deployments, you can now perform image updates at a fabric level using a simple two-step workflow: Prepare & Install. NDFC can optionally automatically generate an upgrade plan for an existing fabric by assigning switches into different update groups based on the switch role and operational state. Users are free to customize the groups as they deem appropriate before they can proceed with the actual update. The Image Management page is now: Fabric Software.
 The navigation path to the new Fabric Software is now: 
 Manage > Fabric Software
 For more information, see the section “Upgrade or Downgrade Switches in a Fabric” in Nexus Dashboard Fabric Controller Fabric Software.
  
      
 
      
    
 
   
 
   [bookmark: _Hlk104847314]LAN Controller Enhancements
 
    
     
      
       
       	 Product Impact
  
       	 Feature
  
       	 Description
  
      
 
      
      
       
       	 Security
  
       	 Security for VXLAN EVPN fabrics using security groups
  
       	 Security for VXLAN EVPN fabrics using security groups is a beta feature that is visible in the Cisco NDFC GUI. This feature is not supported in this release. Contact Cisco for information about this feature.
  
      
 
       
       	 Ease of Use
  
       	 Ability to export switch inventory information to a .csv format
  
       	 Beginning with NDFC release 12.2.1, you can export switch inventory information to a .csv format. For more information, see the “Switches” section in About Fabric Overview for LAN Operational Mode Setups.
  
      
 
       
       	 Ease of Use
  
       	 Custom time range and real-time options available for monitoring performance data
  
       	 Beginning with NDFC release 12.2.1, for the Interface and Link tabs on the Metrics page, you can filter performance data that is shown using new Real time and Custom options. For more information, see the “Metrics” section in About Fabric Overview for LAN Operational Mode Setups.
  
      
 
       
       	 Ease of Use
  
       	 Support added for automatically importing a pre-provisioned device to a fabric using PowerOn Auto Provisioning (POAP)
  
       	 When you enable this feature, NDFC automatically imports the pre-provisioned device to the fabric using POAP. You enable this feature using the Auto admit pre-provisioned switches during re-poap option on the Admin > System Settings > Server Settings > LAN-Fabric tab. With this feature, you can avoid having to reenter a username, password, and the bootstrap parameters on the Add Switches (Bootstrap) page.
 For more information, see the “Automatically Importing a Pre-provisioned Device Using POAP” section in Add Switches for LAN Operational Mode.
  
      
 
       
       	 Ease of Use
  
       	 Support added for both synchronous and asynchronous options for moving a device from normal to maintenance mode and vice versa
  
       	 When you enable this feature and you perform a switch change mode request from NDFC, the specified switch goes to maintenance mode and the NDFC GUI waits until the mode is completely changed on the switch. 
 After the NDFC GUI completes the switch change mode request, the switch changes mode to maintenance or normal mode based on your selection.
 You enable the Wait for switch mode change to maintenance on deploy option from the Fabric Overview > Switches page, the Actions drop-down list on the Manage > Inventory > Switches page, or by double-clicking on a fabric to access a switch on the Topology page. You can then right-click on the switch and click More > Change Mode to access the Change Mode dialog box.
 For more information, see the “Waiting for a Switch to Change Modes” section in Add Switches for LAN Operational Mode.
  
      
 
       
       	 Ease of Use
  
       	 Support for import or export of NDFC templates to or from a Git repository
  
       	 With this feature, you can import or export your non-default NDFC templates to or from your Git repository. For more information, see the “Importing a Template from Git” and “Exporting a Template to Git sections in Templates.
  
      
 
       
       	 Security
  
       	 Support for NDFC discovery of IOS-XR devices without requiring SNMP configuration
  
       	 With this feature, you can discover an IOS-XR device without having to configure the Simple Network Management Protocol version 3 (SNMPv3) on the device. NDFC uses the Secure Shell (SSH) CLI option for IOS-XR device discovery. 
 For more information, see the "VRF Lite Between Cisco Nexus 9000 Based Border and Non-Nexus Device" section in VRF Lite.
 For more information, see the “Managing Cisco IOS-XR Devices using NDFC” section in External Connectivity Networks.
  
      
 
       
       	 Security
  
       	 Support authentication, authorization, and accounting (AAA) remote authentication passthrough
  
       	 With this feature enabled, when you log on to ND, the user’s login credentials are copied to the LAN switch settings in Admin > Switch Credentials > LAN Credentials Management > Default Credentials. When you log on to ND for the first time, you are no longer prompted to enter the LAN switch credentials, as NDFC automatically copies the user login credentials to the LAN switch credentials.
 You can still set per user per switch credentials. Enable this feature by navigating to Admin > System Settings > LAN-Fabric and checking the checkbox for the Enable AAA Passthrough feature. For more information, see the ”LAN-Fabric” section in Overview and Initial Setup of Cisco NDFC LAN.
  
      
 
       
       	 Base Functionality
  
       	 Added support for additional Cisco Catalyst 9000 switches
  
       	 Support added for Cisco Catalyst switches for LAN deployments. For more information, see the “New Hardware Features > Cisco Catalyst Switches for LAN Deployments” section in the Nexus Dashboard Fabric Controller Release Notes, Release 12.2.1.
  
      
 
       
       	 Ease of Use
  
       	 Support for border gateway (BGW) in BGP fabrics for VXLAN EVPN Multi-Site
  
       	 Beginning with NDFC release 12.2.1, border gateway (BGW) support is available in eBGP-based fabrics. The supported roles are Border Gateway, Border Gateway Spine, and Border Gateway Super Spine. Furthermore, the eBGP-based fabric can now participate in a VXLAN EVPN Multi-Site domain (MSD). For more information, see the “Border Gateway Support” section in BGP Fabric.
  
      
 
       
       	 Ease of Use
  
       	 Support for Layer 3 VNI in VXLAN EVPN fabrics without requiring a core-facing VLAN/SVI
  
       	 Beginning with NDFC release 12.2.1, in a VXLAN BGP EVPN fabric, support is available for configuring a Layer 3 VNI (also known as a VRF on a NX-OS device) without needing a VLAN/SVI. This is available for the following fabric types:
 ·  BGP (eBGP EVPN)
 ·  Campus VXLAN EVPN 
 ·  Data Center VXLAN EVPN
 A new field is available when creating or editing these fabric types to enable this feature. For more information, see the “Layer 3 VNI Without VLAN” section in BGP Fabric, in Campus VXLAN EVPN, and in Data Center VXLAN EVPN.
  
      
 
       
       	 Ease of Use
  
       	 Support for AI/ML QoS and queuing policies
  
       	 Beginning with NDFC release 12.2.1, support is available for configuring artificial intelligence (AI) and machine learning (ML) QoS and queuing policies when creating or editing the following fabric types:
 ·  BGP (with or without VXLAN EVPN enabled)
 ·  Data Center VXLAN EVPN
 A new field is available when creating or editing these fabric types to enable this feature. For more information, see the “AI/ML QoS Classification and Queuing Policies” section in BGP Fabric and in Data Center VXLAN EVPN.
  
      
 
       
       	 Performance and Scalability
  
       	 Support for 250 switches with NDFC plus NDI in a three-node physical ND (pND) deployment 
  
       	 This feature increases the scale limits for cohosting Nexus Dashboard Insights (NDI) with NDFC on a three-node physical Nexus Dashboard cluster. The scale limit has been increased from 50 to 250 switches.
 For more information on the verified scalability values for NDFC, see the Verified Scalability Guide for Cisco Nexus Dashboard Controller.
  
      
 
       
       	 Base Functionality
  
       	 Support for Nexus 3000 switches at the Layer 2 access layer for the Enhanced Classic LAN fabric
  
       	 Cisco Nexus 3000 Series switches with an access role are now supported in the Enhanced Classic LAN fabric.
 For more information, see Managing Legacy/Classic Networks in Cisco Nexus Dashboard Fabric Controller.
  
      
 
       
       	 Base Functionality
  
       	 Support for IP ACLs using native NDFC policies for existing as well as new VXLAN EVPN and Enhanced Classic LAN fabrics
  
       	 In earlier releases, IP/IPv6 based ACLs were learnt into switch freeform policies. From NDFC release 12.2.1, these ACLs will be learnt into native ACL policies for VXLAN EVPN and Enhanced Classic LAN fabrics.
 For more information, see Enabling Freeform Configurations on Fabric Switches.
  
      
 
      
    
 
   
 
   SAN Controller Enhancements
 
    
     
      
       
       	 Product Impact
  
       	 Feature
  
       	 Description
  
      
 
      
      
       
       	 Ease of Use
  
       	 Ability to monitor zone, Fibre Channel Name Server (FCNS), and Fabric login (FLOGI) limitations
  
       	 Support is now available to monitor zone, Fibre Channel Name Server (FCNS), and Fabric login (FLOGI) limitations.
 For more information, see the “Monitoring Zone/FCNS/FLOGI Limitations” section in About Switch Overview for SAN Operational Mode Setups.
  
      
 
       
       	 Ease of Use
  
       	 Support for viewing power utilization
  
       	 With this feature, you can view the power utilization for each switch and power module. You can view a graph of power usage data per day, week, or month based on the selected data type. 
 For more information, see the “Metrics” sections in About Switch Overview for SAN Operational Mode Setups and in About Fabric Overview for SAN Operational Mode Setups.
  
      
 
       
       	 Ease of Use
  
       	 Configure VSAN port membership and port trunking allowed VSAN membership directly from the Interface tab
  
       	 With this feature, you can edit VSAN port membership and port trunking allowed VSAN membership directly from the Interface tab for the specified interface.
 For more information, see the “Edit Port VSAN Membership” and the “Edit VSAN Membership with Port Trunking” sections in About Switch Overview for SAN Operational Mode Setups.
 For more information, see the “Edit Port VSAN Membership” and the “Edit Port Trunking VSAN Membership” sections in About Fabric Overview for SAN Operational Mode Setups.
  
      
 
       
       	 Ease of Use
  
       	 Support for clearing FICON RNID status
  
       	 With this feature, you can clear the fiber connectivity (FICON) Request Node Identifier (RNID) status by replacing a value of old with invalid.
 For more information, see the “Clear FICON RNID Old Value” section in About Switch Overview for SAN Operational Mode Setups and in About Fabric Overview for SAN Operational Mode Setups.
  
      
 
       
       	 Ease of Use
  
       	 Configure AAA servers for Cisco MDS switches
  
       	 With this feature, you can view or configure authentication, authorization, and accounting (AAA) servers, Lightweight Directory Access Protocol (LDAP), RADIUS, or TACACS+, for Cisco MDS switches. You can also create a search map for attaching an LDAP server group and for managing your LDAP switches.
 For more information, see the “AAA” and the “Creating an AAA Server, Creating an AAA Server, a Server Group, a Search Map, and an Authentication Type” sections in About Fabric Overview for SAN Operational Mode Setups.
  
      
 
       
       	 Ease of Use
  
       	 Custom time range and real-time options available for performance data
  
       	 Beginning with NDFC release 12.2.1, you can filter performance data that is shown using new Real time and Custom options. For more information, see the “Viewing Interfaces” section in About Fabric Overview for SAN Operational Mode Setups and the “Dashboard Overview” section in Overview and Initial Setup of Cisco NDFC SAN.
 For more information, see the “Viewing Performance Information for FC Ports” and “Viewing Performance Information for Ethernet Ports” sections in Add Interfaces for SAN Operational Mode.
  
      
 
       
       	 Ease of Use
  
       	 Allow expansion of network elements in SAN topology
  
       	 With this feature, when you click on a switch or a zone with host and storage devices, you can view the interface nodes connected to that host, storage, or switch. You can toggle a Show Interfaces option from the View drop-down list that allows you to view the connected interfaces. For more information, see the “Show Interfaces Option” section in Overview and Initial Setup of Cisco NDFC SAN.
  
      
 
       
       	 Ease of Use
  
       	 Navigate to specific pages from the top dashlets on the Overview dashboard
  
       	 With this feature, you can navigate to specific pages after clicking a row in the TOP dashlets from the Overview dashboard page. For more information, see  the “Dashboard Overview” section in Overview and Initial Setup of Cisco NDFC SAN.
  
      
 
       
       	 Ease of Use
  
       	 Add grouping to SAN topology
  
       	 With this feature, you can single-click on a VSAN on the SAN Controller > Topology page to display the VSANs slide-in pane. You can filter based on VSAN attributes or based on search criteria. 
 If you click on a VSAN in the slide-in pane, you can see the grouping of hosts, switches, and storage devices connected to the VSAN in the fabric topology. 
 Click on the Status column to view a tooltip displaying the connected switch. 
 Click on a VSAN name to view the number of zones connected to the VSAN. 
 Click a zone name to view the connected host and storage devices for the zone.
 For more information, see the “Viewing Elements in SAN Topology” section in Overview and Initial Setup of Cisco NDFC SAN.
  
      
 
       
       	 Ease of Use
  
       	 Make SAN Web Device Manager optional
  
       	 With this feature, you can disable the SAN Web Device Manager in Admin > System Settings > Feature Management. 
 For more information, see the “Device Manager” section in Add Switches for SAN Operational Mode.
  
      
 
      
    
 
   
 
    
 
   Fabric Controller with IP Fabric for Media (IPFM) Enhancements
 
    
     
      
       
       	 Product Impact
  
       	 Feature
  
       	 Description
  
      
 
      
      
       
       	 Ease of Use
  
       	 IGMP host proxy configuration
  
       	 The Internet Group Management Protocol (IGMP) host proxy feature helps you connect a Protocol Independent Multicast (PIM)-enabled multicast network domain to a domain that does not understand PIM. This feature configures an interface as a proxy interface that proxies PIM join or prune requests that are received on the internal PIM network to IGMP join or leave requests.
 Enable the IGMP source group proxy in the Layer 3 interface using the following policy: int_ipfm_l3_port. You can filter by proxy groups, or you can add a new proxy group.
 
 For more information, see the “Editing an Interface for IPFM Fabrics” section in the IPFM and Classic IPFM.
  
      
 
       
       	 Ease of Use
  
       	 IS-IS support added as a link-state IGP for an IPFM fabric template
  
       	 This feature adds support for the Intermediate System-to-Intermediate System (IS-IS) link-state Interior Gateway Protocol (IGP) in an IPFM fabric template.
 You configure the IS-IS IGP when creating or editing an IPFM fabric template.
 NOTE: Once devices are imported into an IPFM fabric, you cannot change the IGP unless you delete and re-add the devices. 
 For more information, see the “General Parameters” and “Protocols” sections in IPFM and Classic IPFM.
  
      
 
       
       	 Performance and Scalability
  
       	 Extend support for up to 120 switches in a Classic IPFM fabric
  
       	 This feature extends support for up to 120 switches in a Classic IPFM fabric.
 For more information on the verified scalability values for NDFC, see the Verified Scalability Guide for Cisco Nexus Dashboard Controller.
  
      
 
       
       	 Ease of Use
  
       	 IP Fabric for Media (IPFM) for Layer 2 port visibility
  
       	 In previous releases of NDFC, you could view the IPFM flow status only at the Layer 3 boundary, as a physical interface, or as a switch virtual interface (SVI). Layer 2 physical interface visibility was not possible. Beginning with the NDFC 12.2.1 release, visibility into the Layer 2 VLAN is possible below the SVI. You can identify the receiver connected Layer 2 interface.
 View the Layer 2 port and the Layer 3 SVI in the Receiver Interface column, or by clicking on the active link under the Flow Link State column on the Fabric Overview > Flows > Flow Status page. If you click on the active link, you can view the Layer 2 port in the topology diagram with an updated tooltip and a table that includes the Layer 2 port. You can view the Layer 2 receiver port along with the SVI details by navigating to the Overview > Topology page.
 For more information, see the “IPFM and Generic Multicast Flow Status” section in About Fabric Overview for LAN Operational Mode Setups.[bookmark: New_and_Changed_Information][bookmark: _bookmark0]
  
      
 
       
       	 Ease of Use
  
       	 IPFM critical event notifications
  
       	 With this release, you can view IPFM critical events by navigating to Fabric Overview > Event Analytics > IPFM Events. You can click on a Distinguished Name (DN) to view additional information about the DN or to filter information by Identifier, Reason, Time, or Status.
 You configure IPFM event notification retention history and other options from the Fabric Controller > Admin > System Settings > Server Settings > IPFM tab. 
 For more information, see the “IPFM Events” section in About Fabric Overview for LAN Operational Mode Setups and in Overview and Initial Setup of Cisco NDFC LAN.
  
      
 
      
    
 
   
 
    
 
   New Hardware Features
 
   The following is the list of new hardware supported with this release.
 
   ●    N9K-C93400LD-H1 – Cisco Nexus 9300 series TOR chassis with 48 50g ports and 4 400g ports
 
   ●    N9K-C93108TC-FX3 – Cisco Nexus 9300 series 1RU TOR chassis with 48x100M/1G/10G BASE-T downlinks and 6x40/100G uplinks
 
   Cisco Catalyst Switches for LAN Deployments
 
   ●    Cisco Catalyst 9500X-28C8D – Cisco Catalyst 9500 series 
 
   ●    Cisco Catalyst 9600X-Sup2 – Cisco Catalyst 9600 series supervisor 2 module
 
   ●    Cisco Catalyst C9600-LC-40YL4CD – Cisco Catalyst 9600 series line-card module
 
   Changes in Behavior
 
   ●    Beginning with the NDFC 12.2.1 release, you can import alarm policies from a .txt file using the Import Policy dialog box from the Actions > Import drop-down list. For more information, see the “Alarm Policies” section in Event Analytics.
 
   ●    Beginning with Nexus Dashboard release 3.1(1), all services have been unified into a single deployment image. You no longer need to download, install, and enable each service individually. Instead, you can simply choose which services to enable during the Nexus Dashboard platform deployment process. As a result, we recommend deploying Nexus Dashboard release 3.1(1) with the unified installation for all new installations. Upgrading to this release also automatically upgrades all services on your existing cluster. For more information, see the Cisco Nexus Dashboard and Services Deployment Guide.
 
   Changes to Navigation
 
   Beginning with NDFC release 12.2.1, the navigation to some pages in the GUI have changed. The following table provides information on the navigation paths to those pages prior to release 12.2.1 and the new navigation paths for 12.2.1 and later.
 
    
     
      
       
       	 GUI Page
  
       	 Navigation Prior to Release 12.2.1
  
       	 Navigation for Release 12.2.1 and Later
  
      
 
      
      
       
       	 Active Zones
  
       	 SAN > Active Zones
  
       	 Analyze > Active Zones
  
      
 
       
       	 Backup and Restore
  
       	 Operations > Backup and Restore
  
       	 Admin > Backup and Restore
  
      
 
       
       	 Change Control
  
       	 Operations > Change Control
  
       	 Manage > Change Control
  
      
 
       
       	 End Devices
  
       	 SAN > End Devices
  
       	 Manage > Inventory > End Devices
  
      
 
       
       	 Event Analytics
  
       	 Operations > Event Analytics
  
       	 Analyze > Event Analytics
  
      
 
       
       	 Fabrics
  
       	 LAN > Fabrics
 SAN > Fabrics
  
       	 Manage > Fabrics
  
      
 
       
       	 Feature Management
  
       	 Settings > Feature Management
  
       	 Admin > System Settings > Feature Management
  
      
 
       
       	 Host Path Redundancy
  
       	 SAN > Host Path Redundancy
  
       	 Analyze > Host Path Redundancy
  
      
 
       
       	 Hosts
  
       	 SAN > Hosts
  
       	 Manage > Inventory > Hosts
  
      
 
       
       	 Image Management
  
       	 Operations > Image Management
  
       	 Manage > Fabric Software
  
      
 
       
       	 Interfaces
  
       	 SAN > Interfaces
  
       	 Manage > Inventory > Interfaces
  
      
 
       
       	 LAN Credentials Management
  
       	 Settings > LAN Credentials Management
  
       	 Admin > Switch Credentials > LAN Credentials Management
  
      
 
       
       	 License Management
  
       	 Operations > License Management
  
       	 Admin > Licensing
  
      
 
       
       	 Links
  
       	 SAN > Links
  
       	 Manage > Inventory > Links
  
      
 
       
       	 Networks
  
       	 LAN > Fabrics > Networks
  
       	 Manage > Fabrics > Fabric Overview > Networks
  
      
 
       
       	 NX-API and Bootstrap Certificates
  
       	 Operations > NX-API and Bootstrap Certificates
  
       	 Admin > Certificate Management
  
      
 
       
       	 Port Monitoring
  
       	 SAN > Port Monitoring
  
       	 Manage > Port Monitoring
  
      
 
       
       	 Programmable Reports
  
       	 Operations > Programmable Reports
  
       	 Analyze > Reports
  
      
 
       
       	 Route Peering
  
       	 Services > Route Peering
  
       	 Manage > Fabrics > Fabric Overview > Services > Route Peering
  
      
 
       
       	 Server Settings
  
       	 Settings > Server Settings
  
       	 Admin > System Settings > Server Settings
  
      
 
       
       	 Storage Devices
  
       	 SAN > Storage Devices
  
       	 Manage > Inventory > Storage Devices
  
      
 
       
       	 Switches
  
       	 LAN > Switches
 SAN > Switches
  
       	 Manage > Inventory > Switches
  
      
 
       
       	 Templates
  
       	 Operations > Templates
  
       	 Manage > Templates
  
      
 
       
       	 Topology
  
       	 LAN > Topology
 SAN > Topology
  
       	 Overview > Topology
  
      
 
       
       	 Zoning
  
       	 SAN > Zoning
  
       	 Manage > Zoning
  
      
 
      
    
 
   
 
   Compatibility
 
   Cisco Nexus Dashboard Version Compatibility
 
   NDFC 12.2.1 is bundled with the ND 3.1.1l image. There is no longer any separate option for upload of applications into the Nexus Dashboard. Nexus Dashboard is now a single unified product. 
 
   Supported Cisco Platforms and Software Versions
 
   For compatibility of NDFC release 12.2.1 with various switches, applications, and other devices, see the Compatibility Matrix for Nexus Dashboard Fabric Controller.
 
   For compatibility of NDFC release 12.2.1 with specific Nexus Dashboard, services, and fabric versions, see the Cisco Nexus Dashboard and Services Compatibility Matrix.
 
   For information on cluster sizing guidelines, co-hosting scenarios, and supported form factors, see Nexus Dashboard Capacity Planning tool.
 
   For the list of supported non-Nexus and third-party platforms in this release, see the Compatibility Matrix for Cisco NDFC.
 
   Supported Web Browsers
 
   Cisco NDFC is supported on the following Web browsers:
 
   ●    Google Chrome version 109.0.5414.87 (64 bit)
 
   ●    Microsoft Edge version 109.0.1518.61 (64 bit)
 
   ●    Mozilla Firefox version 108.0.1 (64 bit)
 
   Open Issues
 
   The following table lists the Open bugs for Cisco NDFC, Release 12.2.1. Click the bug ID to access the Bug Search Tool and see additional information about the caveat.
 
    
     
      
       
       	 Bug ID                    
  
       	 Description
  
       	 Exists in          
  
      
 
      
      
       
       	 CSCwm38029
  
       	 When a remote user executes any operation through Nexus Dashboard Orchestrator, the changes are recorded as being performed by the local admin user of Nexus Dashboard running Nexus Dashboard Fabric Controller, rather than the remote user.
  
       	 12.2.1 and later
  
      
 
       
       	 CSCwi52337
  
       	 When NDFC attempts status discovery of a device, the Manage > Inventory table displays "Session Error (Code 103)" on the device.
  
       	 12.2.1 and later
  
      
 
       
       	 CSCwi54582
  
       	 When you navigate to the Manage > Inventory > Switches tab, you may see a configuration status of NA in the Config Status column that displays for more than an hour. Also, you might encounter an error message when NDFC performs a recalculation configuration indicating that configuration compliance is in a transient state. If you encounter such an error, retry the operation.
  
       	 12.2.1 and later
  
      
 
       
       	 CSCwi79166
  
       	 After a fresh installation of Nexus Dashboard (ND) or a clean wipe of the Nexus Dashboard Fabric Controller (NDFC), NDFC displays as "Healthy" prematurely while NDFC internal components are still initializing.
  
       	 12.2.1 and later
  
      
 
       
       	 CSCwj01445
  
       	 In a multi-attach scenario, if only one attachment is failing and the rest are valid, NDFC should allow you to proceed with that attachment and give you a warning. If all the attachments are failing, NDFC should not allow you to proceed.
  
       	 12.2.1 and later
  
      
 
       
       	 CSCwj05451
  
       	 When you navigate to the Manage > Inventory > Switches tab, and you notice that the device displays an SSH error in the Discovery Status column and the model number is empty in the Model column, restart all the workers as described in the workaround text for this incident.
  
       	 12.2.1 and later
  
      
 
       
       	 CSCwj23120
  
       	 The Precision Time Protocol (PTP) monitoring option is missing for switches in Classic LAN fabrics. Contact Cisco Technical Support for more information.
  
       	 12.2.1 and later
  
      
 
       
       	 CSCwj38937
  
       	 The Nexus Dashboard Fabric Controller service fails to enable after an upgrade if a Domain Name System (DNS) server is unavailable.
  
       	 12.2.1 and later
  
      
 
       
       	 CSCwm07977
  
       	 For Orchestrator NDFC-based fabrics, configuration changes pushed from Orchestrator may fail and the NDFC sites may change to "down" state in the Orchestrator’s status page during the change.
 Additionally, restart of LAN Fabric PODs may also occur.
  
       	 12.2.1 and later
  
      
 
      
    
 
   
 
    
 
   Resolved Issues
 
   The following table lists the Resolved bugs for Cisco NDFC Release 12.2.1. Click the bug ID to access the Bug Search Tool and see additional information about the bug.
 
    
     
      
       
       	 Bug ID                    
  
       	 Description
  
       	 Fixed in          
  
      
 
      
      
       
       	 CSCwe60313
  
       	 When creating port-channel interfaces on Cisco Catalyst 9000 series switches, your deployment might fail and display one of the following messages:
 
         
         ●   
         Deployment failure of "channel-group 6 mode active" with error "Delivery failed with message:%Command rejected : MTU Config mismatch for interface Te8/1/6 in group 6" 
        
 
         
         ●   
         Deployment failure of "channel-group 2 mode active" with error "Delivery failed with message:Command rejected: Either port is L2 and port-channel is L3, or vice-versa", or deployment failure on "switchport mode" with message "Po6 is not a switching port" on a Layer 2 PO. 
        
  
       	 12.2.1
  
      
 
       
       	 CSCwe89560
  
       	 On the Fabric Overview > Interfaces tab, Sync Status displays as NA for port channel and vPC interfaces.
  
       	 12.2.1
  
      
 
       
       	 CSCwh08204
  
       	 If a primary node with Elasticsearch in a 3-node cluster shuts down, the active alarm pod goes down and becomes active on another node. In this case, Operations > Event Analytics > Alarms > Alarms Policies may not show any default or existing policies.
  
       	 12.2.1
  
      
 
       
       	 CSCwh15025
  
       	 When deleting Border Gateway switches with overlay extensions which has 'Force delete border role switches' enabled, the system may not remove some switches at the first attempt.
  
       	 12.2.1 
  
      
 
       
       	 CSCwh26528 
  
       	 The credentials from Credentials Management System (CMS) that appear on Actions > Edit Fabric misses an entry of UCS SNMP credential. This happens due to a schema change after restoring NDFC from 11.5.4 to 12.1.x. However, this does not have an impact on SAN discovery as it reconstructs the UCS SNMP user and saves to its own cache.
  
       	 12.2.1
  
      
 
       
       	 CSCwh29489
  
       	 The address family for VRF context of BGP gets negated in Pending Config when Export Gateway IP for service_static_route and service_ebgp_route templates is changed from enabled to disabled in the Route Peering of L4-L7 services for VXLAN EVPN fabric.
  
       	 12.2.1
  
      
 
       
       	 CSCwh29913
  
       	 Missing policies or configuration diffs are observed after manual RMA on the Catalyst 9K switches in a Campus VXLAN EVPN fabric.
  
       	 12.2.1
  
      
 
       
       	 CSCwh30266
  
       	 When you run pre-ISSU and post-ISSU reports using the custom_swift_issu template on a switch, the post-ISSU report fails for the 'Validate License Usage' category in the report.
  
       	 12.2.1
  
      
 
       
       	 CSCwh31460
  
       	 While performing Recalculate & Deploy, you may get a traceback with getPersistentIp(): expected 2 args.
  
       	 12.2.1
  
      
 
       
       	 CSCwh35272
  
       	 While performing a Recalculate & Deploy on switches that are imported with preserve-config ‘yes’ in an Enhanced Classic Lan fabric (Brownfield migration), the following error appears:
 Error updating VRF Id [50000] Name [default]. Reason [OSPFv3 Process Tag needs to be defined in Fabric Settings for VRF default of IP version IPv4_and_IPv6]
  
       	 12.2.1 and later
  
      
 
       
       	 CSCwh53141
  
       	 After a reload of any one of the nodes, all the fabric data may appear to be lost in the NDFC user interface.
  
       	 12.2.1 and later
  
      
 
       
       	 CSCwh62924
  
       	 vCenter Visualization plugin crash when VMware DVS configured with PVLAN.
  
       	 Releases prior to 12.1.3b
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       	 Bug ID                    
  
       	 Description
  
       	 Exists in          
  
      
 
      
      
       
       	 CSCwd84563
  
       	 Upgrade to v2.3 from v2.1.2d - No warning messages to disable old App/containers.
  
       	 Nexus Dashboard Release 2.1.2d
  
      
 
       
       	 CSCwd85885
  
       	 Network creation error on upgraded setup.
  
       	 12.0.1a
  
      
 
       
       	 CSCwe53978
  
       	 Persistent configuration difference is observed for ‘ip dhcp relay address’ command.
  
       	 12.1.2 
  
      
 
       
       	 CSCwf12259
  
       	 For a SAN fabric, the timelines beneath the graph on Congestion Analysis are not accurately aligned for the interface graphs.
  
       	 12.1.3b 
  
      
 
       
       	 CSCwf14008
  
       	 On SAN Insights for a host, the Rx/Tx graphs for a switch interface appear as truncated.
  
       	 12.1.3b 
  
      
 
       
       	 CSCwh30277 
  
       	 When you perform an install or upgrade using a Software Maintenance Upgrades (SMU) image, the upgrade status fails to change from out-of-sync to in-sync.
  
       	 12.1.3b
  
      
 
      
    
 
   
 
    
 
   Related Content
 
   Navigating the Cisco Nexus Dashboard Fabric Controller Documentation 
 
   The documentation for Nexus NDFC is available on the Help Center in the GUI. To access Help Center: 
 
   1.     Log in to your Nexus Dashboard Fabric Controller GUI. 
 
   2.     In the top-right corner of the main window, click the help icon (?), and then click Help Center.
 The Nexus Dashboard Help Center opens in another tab of your Web browser.
 
   3.     In the Services area, click on Fabric Controller to open the Fabric Controller Help Center.
 
   4.     From the User Content for drop-down list, choose LAN or SAN to view the list of documents for LAN or SAN, as required.
 
   Platform-Specific Documents 
 
   The documentation set for platform-specific documents that Cisco NDFC manages includes the following: 
 
   Cisco Nexus 2000 Series Fabric Extender Documentation 
 
   https://www.cisco.com/c/en/us/products/switches/nexus-2000-series-fabric-extenders/index.html
 
   Cisco Nexus 3000 Series Switch Documentation 
 
   https://www.cisco.com/c/en/us/support/switches/nexus-3000-series-switches/series.html
 
   Cisco Nexus 4000 Series Switch Documentation
 
   https://www.cisco.com/c/en/us/support/switches/nexus-4000-series-switches/series.html
 
   Cisco Nexus 5000 Series Switch Documentation 
 
   https://www.cisco.com/c/en/us/support/switches/nexus-5000-series-switches/series.html
 
   Cisco Nexus 6000 Series Switch Documentation 
 
   https://www.cisco.com/c/en/us/support/switches/nexus-6000-series-switches/series.html
 
   Cisco Nexus 7000 Series Switch Documentation 
 
   https://www.cisco.com/c/en/us/support/switches/nexus-7000-series-switches/series.html
 
   Cisco Nexus 9000 Series Switch Documentation 
 
   https://www.cisco.com/c/en/us/support/switches/nexus-9000-series-switches/series.html
 
   Nexus Dashboard and Services Documentation
 
   ●    Cisco Nexus Dashboard Release Notes 
 
   ●    Cisco Nexus Dashboard Orchestrator Release Notes 
 
   ●    Cisco Nexus Dashboard Insights Release Notes 
 
   ●    Cisco Nexus Dashboard Capacity Planning
 
   ●    Cisco Nexus Dashboard and Services Compatibility Matrix
 
   Documentation Feedback
 
   To provide technical feedback on this document, or to report an error or omission, please send your comments to: ndfc-docfeedback@cisco.com.
 
   You can also use the feedback form available in the right pane of every online document. We appreciate your feedback.
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